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Resumen 

La evaluación de morfometría fetal en modelos experimentales permite determinar el 

efecto de una enfermedad o sustancia química sobre el desarrollo de la descendencia. 

Sin embargo, los estudios morfométricos fetales que convencionalmente se realizan en 

nuestro centro presentan algunas limitaciones como la necesidad de personal 

especializado, el uso de técnicas convencionales poco precisas y eficientes. El análisis 

digital de imágenes y la creación de una guía para orientar el proceso, constituye una 

posible solución a estos problemas. La presente guía fue desarrollada a partir de la 

experiencia de un equipo de investigación multidisciplinario (Unidad de Investigaciones 

Biomédicas y Departamento de Ciencias Básicas Biomédicas Morfológicas, UCM-VC) y 

del análisis de la literatura científica acerca de esta temática. Proporciona los 

conocimientos básicos en morfometría y análisis digital de imágenes necesarios para 

una adecuada evaluación de morfometría fetal, sin necesidad de ser especialistas en 

estas técnicas. El lenguaje sencillo, la detallada descripción de los procedimientos y las 

imágenes proporcionadas por los propios autores, facilitan su comprensión. Se 

pretende que este material aporte eficiencia y precisión durante el proceso, que 

constituya una fuente útil de información científica y un nuevo aporte al programa de 

informatización en Cuba. 

Introducción 

El término “morfometría” se refiere al estudio de la variación de la forma de los órganos 

y organismos, así como su covariación con otras variables. También se define como la 

fusión entre la geometría y la biología que se encarga de estudiar la forma en dos o 

tres espacios dimensionales. Constituye una rama de la estadística y de la morfología 

con un amplio rango de aplicaciones (1). 

La evaluación de morfometría fetal en modelos experimentales puede aportar 

información relevante sobre el efecto de una enfermedad o sustancia química sobre la 

descendencia. Permite evaluar el crecimiento y desarrollo del feto bajo determinadas 

condiciones, así como realizar el diagnóstico de anomalías (2-4). Sin embargo, los 
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estudios morfométricos fetales que convencionalmente se realizan en nuestro centro 

presentan algunas limitaciones. 

Una de las principales limitaciones es la necesidad de personal especializado y 

capacitado durante estos procedimientos. Además, las mediciones habitualmente se 

realizan con pie de rey, una técnica que no resulta apropiada para la medición de 

áreas, estructuras pequeñas o de difícil acceso y que puede generar un sesgo si lo 

realizan diferentes investigadores. También resulta trabajoso realizar todas las 

mediciones requeridas a cada feto después de extraído debido a la inmediatez del 

proceso, tamaño de las camadas y variables a procesar. Los fetos no se encuentran 

disponibles si se desea realizar una nueva consulta, ya que se destinan a diferentes 

tipos de estudios (bioquímico, esquelético, visceral). La sustitución de la medición “en 

fresco” por el análisis digital de imágenes y la creación de una guía para orientar el 

proceso, constituye una posible solución a estos problemas.  

La presente guía fue desarrollada a partir de la experiencia de un equipo de 

investigación multidisciplinario (Unidad de Investigaciones Biomédicas y Departamento 

de Ciencias Básicas Biomédicas Morfológicas, UCM-VC) y del análisis de la literatura 

científica acerca de esta temática. Proporciona los conocimientos básicos en 

morfometría y análisis digital de imágenes necesarios para una adecuada evaluación de 

morfometría fetal sin necesidad de ser especialistas en estas técnicas.  

Está dirigida principalmente a investigadores, técnicos, profesores y estudiantes que 

necesiten realizar una adecuada evaluación de morfometría fetal en modelos 

experimentales o incluso, en humanos. Además, puede ser utilizada por investigadores 

de otros campos del conocimiento (ecología, microbiología, etc.) que precisen el uso de 

un software como ImageJ para el análisis digital de imágenes. Esperamos que este 

material constituya una fuente útil de información científica y un nuevo aporte al 

programa de informatización en Cuba. 
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Desarrollo 

El análisis o procesamiento digital de imágenes, incluye un conjunto de técnicas que 

operan sobre la representación digital de una imagen, con el objetivo de facilitar su 

posterior análisis por parte de un usuario (humano) o un sistema de visión artificial (5; 

6). Sin embargo, no es necesario ser especialista en estas herramientas para 

utilizarlas.  

Las técnicas de análisis y procesamiento digital de imágenes constituyen un método 

novedoso y óptimo para realizar el análisis morfométrico fetal (7; 8; 4; 9). Permiten 

realizar mayores mediciones y más exactas, en menor tiempo, con mayor comodidad y 

poco gasto de recursos. Por tanto, aportan mayor eficiencia y eficacia en el proceso. 

Además, permiten maximizar la información obtenida por animal evitando el uso 

posterior de otros animales, una alternativa de reducción propuesta en el Principio de 

las Tres Erres para la experimentación animal. 

PREPARACIÓN DEL LOCAL Y REGISTRO FOTOGRÁFICO 

Primeramente, se debe destinar un área de trabajo con poca humedad y buena 

iluminación para el registro fotográfico de los fetos. Se recomienda utilizar un trípode, 

un patrón o referencia (regla, papel milimetrado) y la misma cámara fotográfica 

durante todo el estudio, con el objetivo de minimizar la variabilidad durante el proceso 

(Figura 1A). La regla (o patrón) se debe encontrar en el mismo plano del objeto de 

interés y paralelo al plano del lente (Figura 1A). La imagen del feto debe quedar lo más 

centrada posible para evitar variabilidad en las mediciones. Se recomienda colocar de 

forma clara una identificación (enumeración del feto y de la rata progenitora si es 

necesario) en un lugar visible y cómodo para el investigador (Figura 1A). 

Para la manipulación de los animales se recomienda cumplir con los aspectos éticos 

expuestos en la Guía para el Cuidado y Uso de Animales de Laboratorio (2013) (10). 

También es importante tener precaución al manipular la cámara fotográfica, sobre todo 

después de realizar la cesárea o manipular los fetos, para evitar dañar el equipo o 

comprometer la calidad de la imagen. De ser posible, activar la opción de menú en el 

cual las líneas de la cuadrícula se muestran en el visor o la pantalla. Estas líneas se 
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utilizan como guía para encuadrar la imagen y no aparecen en la fotografía definitiva 

(Figura 1A). 

Para los registros fotográficos del feto (completo) se recomienda colocar el mismo 

sobre la mesa de trabajo, encima de una superficie (tela, papel, placa de Petri) en 

posición neutral (no hiperextendido o flexionado). En el caso de las mediciones 

cráneo-faciales se recomienda sujetar el feto por el cráneo o el tronco (en 

dependencia de la posición requerida) y situar la regla aproximadamente en el mismo 

plano del objeto de interés. Se deben tomar imágenes de la vista lateral derecha e 

izquierda tanto en el feto completo como en la región del cráneo, así como realizar las 

mediciones en cada una. Los autores eligieron la vista lateral derecha como referencia 

para explicar cada caso. El investigador puede tomar imágenes en todos los planos 

que considere conveniente, pero se proponen registros fotográficos en las siguientes 

vistas: 

 

- Vistas para realizar el registro fotográfico de los fetos: Vista ventral, Vista lateral 

derecha y Vista dorsal (Figuras 1B y 4). 

- Vistas para realizar el registro fotográfico de la región craneal de los fetos: Vista 

frontal 1, Vista frontal 2, Vista lateral derecha e izquierda, Vista superior (Figuras 1B 

y 5). 

 

SELECCIÓN Y PROCESAMIENTO DE IMÁGENES 

Una vez realizado el registro fotográfico de los fetos, las imágenes se deben almacenar 

para su posterior análisis. Se recomienda depositar varias copias de este repositorio en 

diferentes computadoras o en “La nube”, para evitar la pérdida de las mismas. 

El proceso de selección debe ser cuidadoso. Es necesario elegir por cada posición las 

imágenes más nítidas y con mejor encuadre. Si para una determinada posición ninguna 

de las fotografías presentó la calidad deseada se puede utilizar algún software de 

edición fotográfica, como el Adobe Photoshop. En caso de tener Windows 10 instalado, 

se puede utilizar la opción de edición de imágenes que brinda el programa “Fotos” de 
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Windows. De esta forma la imagen se puede recortar, girar y enderezar, así como 

ajustar el brillo, la claridad o el contraste. En este caso es necesario tener en cuenta los 

aspectos éticos relacionados con el pre-procesamiento de las imágenes científicas, 

donde el proceso de edición nunca debe comprometer el resultado. 

TOMA DE MEDICIONES MEDIANTE EL ANÁLISIS DIGITAL DE IMÁGENES 

El trabajo con Image J 

Existe una amplia gama de herramientas de software, tanto comerciales como de 

código abierto que permiten el análisis digital de imágenes. Sin embargo, para trabajar 

en una imagen científica se requiere un programa científico. ImageJ es un programa de 

procesamiento de imágenes diseñado para imágenes científicas, desarrollado por 

Wayne Rasband en el U.S. National Institutes of Health (NIH) y que está en continuo 

desarrollo desde 1997 (11). 

Además de ser creado con fines científicos, ImageJ presenta otras ventajas. Puede 

descargarse gratuitamente desde https://imagej.nih.gov/ij, por lo que es accesible 

para todos los investigadores. Además, el código fuente de ImageJ es de dominio 

público, por lo que no está sujeto a derechos de autor. Esta característica promueve su 

distribución y modificación con solo citar la fuente. Al estar construido con Java (de 

aquí la “J” del nombre) funciona en cualquier sistema operativo (Windows, Linux y Mac 

OS X), para 32-bit o 64-bit (12). 

ImageJ cuenta con una barra de trabajo, sencilla, pequeña y flotante en el escritorio de 

su computadora. La misma posee tres secciones:  

- Menús: despliega más accesos como File (Archivo), Edit (Editar), Image (Imagen), 

Process (Procesar), Analyze (Analizar), etc.  

- Botones de herramientas: permite elegir la herramienta de trabajo, ej: selección 

de área rectangular, oval, puntos, zoom, etc. 

- Barra de Información: en forma de texto en la parte inferior, cambia dependiendo 

de la herramienta seleccionada. 

https://imagej.nih.gov/ij
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Primeramente se debe abrir el programa haciendo doble clic en el ejecutable 

(ImageJ.exe). Para abrir una imagen se puede arrastrar la misma hasta la barra de 

trabajo de ImageJ o hacerlo desde el menú File > Open. ImageJ está configurado para 

abrir cualquier formato de imagen, los más usados son Jpg y Tiff. Sin importar el 

formato de la imagen, la información está en píxeles (12).  

Después de tener abierto el archivo, la primera operación que se debe realizar es 

“calibrar la imagen”. El proceso de calibración espacial consiste en cambiar los píxeles 

de una imagen por valor conocido en mm, cm, micras, etc. Por tanto, la imagen debe 

contener una referencia, como una regla, un papel milimetrado o algún objeto de 

tamaño conocido como se recomendó anteriormente. 

Para calibrar la imagen se recomienda comenzar con la herramienta Zoom 

(representada por una lupa) para que este proceso sea lo más preciso posible. Después 

de hacer clic en la herramienta Zoom, se puede hacer clic sobre la imagen si se desea 

aumentar de tamaño (o tecla “”) y clic derecho, ALT-clic (o tecla “-”) si desea 

reajustar y disminuir el tamaño. La tecla “Espacio” “clic izquierdo sostenido” permite 

desplazarse en la imagen ampliada sin seleccionar. Luego, se recomienda hacer clic 

sobre la herramienta “selección de línea” (la de color gris más oscuro en la Figura 2A) y 

dibujar una línea a lo largo de la referencia de escala (línea amarilla) (Figura 2A y 2B).  

Posteriormente, se debe elegir Analyze> Set scale en la barra de menús (Figura 2B). 

Se abrirá una nueva ventana (Set scale), donde se puede introducir la dimensión de la 

línea dibujada en el cuadro distancia conocida (Known distance) y establecer la unidad 

en la caja unidad de longitud (Unit of length) (11). 

En el caso de imágenes sin escala, existen algunas opciones que pueden funcionar para 

calibrar. Si en la imagen se observa algún objeto de dimensiones conocidas como una 

pinza, dedos, o placas de Petri, éstos pueden ser utilizados para calibrar la imagen. 

Otra opción es utilizar otra foto para calibrar, tomada bajo las mismas condiciones 

(mismo aumento, distancia de la cámara al objeto, etc.) y que contenga algún objeto 

de referencia (regla, objeto de dimensiones conocidas, entre otras). Se deben abrir 

ambas imágenes en ImageJ, calibrar la que tiene la referencia y marcar “Global” 
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(Figura 2C). De esta forma, la calibración realizada en la imagen con la referencia se 

aplicará a las siguientes imágenes y no cambiará a menos que vuelva a calibrar o cierre 

el programa. 

Mediciones 

Después de ejecutar el programa ImageJ, abrir y calibrar la imagen, se puede 

comenzar a medir. Se debe elegir la herramienta de selección en la barra de trabajo 

con la que se desea medir, trazar una línea (recta, a mano alzada, segmentada) o 

dibujar un área en la zona que se desee (Figura 3A). Luego se presiona la letra “m” de 

su teclado (o dirigirse al Menú Analize > Measure) para obtener la medición (5). 

Después de realizar todas las selecciones que deseen se pueden medir con el comando 

Measure, obteniendo una tabla de Result, donde también se pueden calcular valores 

promedios, SD, mínimo y máximo (Figura 3A y 3B). La ventana de resultados 

constituye una tabla de Excel© que se puede guardar para futuros trabajos, utilizando 

File > Save (12).  

Una opción muy útil para realizar varias mediciones en una misma imagen y ver las 

selecciones en orden mientras se dibujan, es la herramienta ROI Manager (Figura 

3C). Se accede a través del Menú Edit> Selection> Add to Manager, mediante el Menú 

Analize > Tools> ROI Manager o presionando la Letra “T” (11). Luego de calibrar la 

imagen y abrir ROI manager, se debe dibujar una línea sobre la estructura que quiere 

medir y hacer clic en Añadir (Add) para agregar la selección actual a la lista (o pulsar 

“t”). Se pueden agregar tantas líneas como mediciones se deseen. Es necesario 

verificar que estén seleccionados Show All y Lables, así se pueden ver las líneas 

mientras se dibujan (Figura 3C).  

Point tool (Figura 5B para conteo de bigot(5)es) es otra herramienta muy útil si lo que 

se necesita es contar. Luego de abrir la imagen y calibrarla, se selecciona la 

herramienta Point tool o Multi-Point (al hacer clic derecho sobre la herramienta) y se 

comienza a hacer clic en las estructuras a contar. Se abrirá una ventana donde se irán 

registrando los puntos contados. Otra opción es presionar la tecla “m” y se mostrará en 

la tabla de resultados el Total, como se muestra en la Figura 2.17. Para borrar un 
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punto se presiona la tecla ALT y se hace clic en el mismo; también se pueden mover 

(5).  

La herramienta Cepillo (brush) selecciona la forma del área utilizando un “pincel” 

circular. El diámetro se puede ajustar haciendo doble clic en el icono de la herramienta 

y comenzar a “pintar” la región que se desea medir. La selección se puede ajustar de 

dos formas: hacer clic en el interior del área de selección y arrastrar a lo largo de su 

límite para ampliar el límite hacia el exterior o hacer clic fuera del área de selección y 

arrastrar hacia adentro para reducir el tamaño. Esta herramienta se puede combinar 

con otras, por ejemplo, se puede comenzar con la herramienta polígono y luego se 

continúa ajustando esa selección con la herramienta cepillo (11). 

Otra forma de seleccionar las zonas es por su color. Para ello se puede utilizar la 

herramienta Varita (wand tool), la cual crea una selección mediante el trazado de los 

objetos de color uniforme. Para realizar la selección se debe hacer clic en el interior del 

mismo y mover el cursor. De esta forma se seleccionarán áreas de color similar. Si se 

hace doble clic en el icono de la herramienta de Varita (o Edit > Options > Wand Tool) 

se abre un cuadro de diálogo de configuración en el cual se puede aumentar el valor de 

tolerancia (Legacy). A mayor tolerancia, mayor el área seleccionada. Si luego de 

realizar la selección se desea medir el área se puede utilizar Analize> Set 

Measurements, y marcar “Area2” (12).  

Las herramientas de selección en la barra de trabajo (rectangular, oval, poligonal y 

mano alzada) se pueden configurar o cambiar. Si se hace doble clic sobre ella se 

despliega un menú contextual que permite establecer parámetros de la herramienta. 

Por otro lado, si se clic con botón derecho del ratón en el triángulo rojo que se 

encuentra en la esquina inferior derecha se puede cambiar de herramienta. Por 

ejemplo, se puede cambiar entre selección oval, elíptica y brush tool (cepillo) (11). 

Todas las mediciones deben ser realizadas por el mismo investigador para evitar 

variabilidad en los resultados. Además, se deben realizar por duplicado para garantizar 

la calidad del análisis. Tenga en cuenta que una misma medición se puede realizar en 

diferentes posiciones del feto para obtener resultados más confiables. Se puede realizar 
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todas las mediciones (Longitudes, áreas, ángulos) que estime conveniente. Las figuras 

4 y 5 representan solo algunas determinaciones que los autores consideran 

importantes, empleando las herramientas “Straight” para las mediciones de diámetro, 

“Oval Selections” para la medición del perímetro cefálico y área cefálica, y “Multi-Point 

Tool” para el conteo de bigotes (Figura 4 y Figura 5). 

Conclusiones 

Se desarrolló en la Unidad de Investigaciones Biomédicas de la Universidad de Ciencias 

Médicas de Villa Clara, la primera guía en Cuba para la evaluación de morfometría fetal 

en modelos experimentales mediante análisis digital de imágenes. La misma describe 

paso a paso cómo realizar una correcta evaluación de morfometría fetal, desde la 

preparación del local, el registro fotográfico, los posibles errores, el trabajo con  ImageJ 

y la toma de mediciones, para su posterior interpretación. El lenguaje sencillo, la 

detallada descripción de los procedimientos y las imágenes proporcionadas por los 

propios autores, facilitan su comprensión.  

Con esta producción se pretende aportar eficiencia, precisión y minimizar el error 

humano durante estos procedimientos. Cualquier profesional, aunque no esté 

previamente capacitado, podrá dominar los conocimientos básicos de morfometría y 

análisis digital de imágenes, necesarios para una adecuada evaluación de morfometría 

fetal. Se podrá invertir menor tiempo y recursos, realizar mayores mediciones, más 

exactas y con mayor comodidad. Las imágenes se podrán almacenar y estarán 

disponibles para consultas posteriores si así se requiere. Además, podrá ser utilizada 

por investigadores de otros campos del conocimiento (ecología, microbiología, etc.) que 

precisen el uso de un software como ImageJ para el análisis digital de imágenes. 

Esperamos que este material constituya una fuente útil de información científica y un 

nuevo aporte al programa de informatización en Cuba. 
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 Anexos 

 

 
 

Figura 1. Condiciones técnicas y posibles errores durante el registro fotográfico de los 
fetos. Posición correcta del trípode, la cámara, el patrón (regla), el feto, la 

identificación y cuadrículas en el visor de la cámara fotográfica (A). Poca iluminación, 
falta de nitidez, ausencia de identificación, regla en un plano diferente al objeto de 
interés (el feto) y errores en la posición del feto (feto hiperextendido, flexionado o 

girado) (B). Imágenes de muestra tomada por los autores con cámara Cannon Power 
Shot G11 (Japón). 
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Figura 2. Calibración con ImageJ. Dibujo de una línea sobre objeto de referencia para 
calibrar la imagen (A). Establecer la calibración con Analyze> Set scale en la barra de 
menús (B). Parámetros de la ventana “Set Scale” y calibración de fotos utilizando dos 

imágenes tomadas bajo las mismas condiciones, una con referencia y otra sin 
referencia (C). Imágenes de muestra tomada por los autores con cámara Cannon 

Power Shot G11 (Japón). 
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Figura 3. Mediciones con ImageJ y herramientas útiles. Medición de la longitud de la 

cola en feto de rata Wistar (A). Ventana de Resultados para cuatro mediciones y 
“Summarize” (B). Herramienta ROI Manager y Tabla de Resultados para la medición de 
la distancia entre los poros nasales (1), la Longitud transversal de la cara (2) y la 

Longitud cráneo-caudal de la cara (3) (C). Imágenes de muestra tomada por los 
autores con cámara Cannon Power Shot G11 (Japón). 
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Figura 4. Vistas y mediciones en el feto con ImageJ. Vista Ventral (A): Diámetro 

transverso del tórax ventral: Medición lineal de izquierda a derecha del tórax a nivel del 
borde inferior de los miembros superiores (1). Diámetro transverso abdominal ventral: 
medición lineal de izquierda a derecha de la parte más saliente del abdomen a nivel del 

último arco costal (2). Diámetro transverso de la pelvis: Medición lineal de izquierda a 
derecha a nivel del punto onfalio (3). Vista lateral derecha (B). Diámetro cáneo 

caudal: distancia desde la parte superior de la cabeza hasta la base de la cola (1). 
Diámetro Abdominal Antero-Posterior Derecho: medición lineal desde la cara posterior 
(piel que recubre la columna vertebral) hasta la pared abdominal anterior, en su punto 

más externo (2). Vista dorsal (C). Talla total: distancia desde la parte superior del 
cráneo  hasta la punta de la cola (1). Diámetro del tronco: distancia desde la base del 

cráneo hasta la base de la cola (2). Diámetro de la cola: distancia desde la base de la 
cola hasta su extremo (3). Diámetro transverso del tórax dorsal: Medición lineal de 
izquierda a derecha del tórax a nivel del borde inferior de los miembros superiores (4). 

Diámetro transverso abdominal dorsal: medición lineal de izquierda a derecha de la 
parte más saliente del abdomen (5). Imágenes de muestra tomada por los autores con 

cámara Cannon Power Shot G11 (Japón). 
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Figura 5. Vistas y mediciones en el feto con ImageJ. Vista Ventral (A): Diámetro 
transverso del tórax ventral: Medición lineal de izquierda a derecha del tórax a nivel del 
borde inferior de los miembros superiores (1). Diámetro transverso abdominal ventral: 

medición lineal de izquierda a derecha de la parte más saliente del abdomen a nivel del 
último arco costal (2). Diámetro transverso de la pelvis: Medición lineal de izquierda a 

derecha a nivel del punto onfalio (3). Vista lateral derecha (B). Diámetro cáneo 
caudal: distancia desde la parte superior de la cabeza hasta la base de la cola (1). 
Diámetro Abdominal Antero-Posterior Derecho: medición lineal desde la cara posterior 

(piel que recubre la columna vertebral) hasta la pared abdominal anterior, en su punto 
más externo (2). Vista dorsal (C). Talla total: distancia desde la parte superior del 

cráneo  hasta la punta de la cola (1). Diámetro del tronco: distancia desde la base del 
cráneo hasta la base de la cola (2). Diámetro de la cola: distancia desde la base de la 

cola hasta su extremo (3). Diámetro transverso del tórax dorsal: Medición lineal de 
izquierda a derecha del tórax a nivel del borde inferior de los miembros superiores (4). 
Diámetro transverso abdominal dorsal: medición lineal de izquierda a derecha de la 

parte más saliente del abdomen (5). Imágenes de muestra tomada por los autores con 
cámara Cannon Power Shot G11 (Japón). 


